
 

 

INT Stereonet 1.0 Technical Guide 
 

 

 

 

 

 

 

 

Interactive Network Technologies, Inc 
2901 Wilcrest, Suite 100 
Houston, Texas 77042  



INT Stereonet 1.0 Technical Guide 
Copyright © Interactive Network Technologies, 2011 

2 
 

Foreword 

The INT Stereonet plug-in provides an essential tool for analyzing plane (faults, horizons, foliations, etc.) 
and line (stream lines, etc.) orientation. It projects each oriented element into a planar image of a 
sphere, which allows for easier grouping of elements by family. 

Features include: 

• Easy interaction with Petrel data tree (import data with optional sampling) 
• Circular statistics generation, including circular and regular histograms; 
• Families creation to help you sort and group your objects; 
• Data edition; 
• Data visualization; 
• Images generation and easy interaction with clipboard; 
• Clear customizable legend; 
• Save / load of Stereonet data. 

This document presents the plug-in interface as well as its main functionalities. Except when specified, 
all options are accessible using the menus, the toolbar, and by right clicking an object in the data 
browser. 

 

 

The INT Support Team is eager to help you. Our goal is to respond to every request in a timely manner. 

To report a new problem, ask for assistance or new features, send an email to support@int.com:  

• Be specific in how we can help you 
• Describe the steps you took to arrive at the problem 
• What was it you were trying to achieve when you ran into trouble?  

We will reply with a ticket ID number and login information if this is the first time you have reported a 
problem.  

To check the status of an existing incident, you can access the INT Support Database. 
Be certain you have your login information and ticket number.  

If you need assistance with login to the support database or have technical questions, send your 
requests to support@int.com.  For general information about our products and services, email us at 
intinfo@int.com or call +1 713.975.7434 

 

  

mailto:support@int.com
https://www.int.com:9443/secure/Dashboard.jspa
mailto:support@int.com
mailto:intinfo@int.com
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Plug-in main window 
The main window of the INTStereonet plug-in is divided into 4 areas: 

• (1): Menus and Toolbar. All the implemented options of INT Stereonet are accessible from here. 
• (2): Data Browser. This tree displays all the loaded, imported or generated datasets. Most of INT 

Stereonet features are also accessible from right-clicking the tree. 
• (3): The stereonet Canvas itself. Points and circular histograms are displayed. Some features are 

also accessible from right-clicking it. 
• (4): Control area. Depending on the current action, this area contains specific functionalities. 
• (5): Status bar. Gives information about current operations. 

Except for crosses or stars, a point located in the South Hemisphere (dip angle between 90 and 180 
degrees) will appear empty: only its boundary will be visible.  

Figure 1: INT Stereonet main window 
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File Menu 
The File menu offers common functionalities. 

 New          Ctrl+Shift+N 
Close the current project and open a new empty one. The new document opens in the same window 
and replaces the closed project. 

 Open          Ctrl+Shift+O 
Open an existing project (previously saved stereonet with a .stn file format). 

 Save          Ctrl+Shift+S 
Save the project as a .stn file. If the project has not been saved yet, it will launch the Save As action. 

 Save As 
Save the project in a new .stn file. 

 Save As Image 
Export the chart as an image. The picture can be saved in several common formats. 

 Print          Ctrl+Shift+P 
Select a printer, number of copies, and other printing options before printing the chart and its legend. 

The chart will be printed with the default zoom, even if the chart has been zoomed in. 

 Print Preview 
Preview the stereonet and sets printing parameters before the print.  

The chart will be previewed with the default zoom, even if the chart has been zoomed in. 
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Edit Menu 
The Edit menu allows for Data Browser Edition. 

 Expand Tree 
Expand all the nodes of the Data Browser. 

 Collapse Tree 
Collapse the Data Browser (only root directories are visible). 

 Create Directory 
This feature is only available when a directory or a data set is selected in the Data Browser. 
Create a new directory as a child of the selected object. 

 Cut          Ctrl+Shift+X 
This feature is only available when an object is selected in the Data Browser. 
Root directories are not removable. 
Cut the selected object and copy it in the clipboard. 

 Copy          Ctrl+Shift+C 
This feature is only available when an object is selected in the Data Browser. 
Copy the selected object in the clipboard. 

 Paste          Ctrl+Shift+V 
This feature is only available if a node has previously been copied or cut. 
Paste the copied node under a directory. A node cannot be pasted directly under another point node, it 
needs a directory node as a parent node. 

 Delete Node        Shift+Del 
This feature is only available when an object is selected in the Data Browser.  
Root directories are not removable. 
Delete the selected object and all its children. Points and histograms will be removed from the chart. Bar 
histograms remain open. 

 Delete Node Content 
This feature is only available when an object is selected in the Data Browser.  
Root directories are not removable. 
Delete the content of the selected object, but not the object itself.   
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Data Menu 
The Data menu allows for Data Edition or customization. 

 Set Visible Y/N 
This feature is only available when a data set is selected in the Data Browser.  
Show or hide the selected node on the chart. 

 Show 
This feature is only available when a histogram is selected in the Data Browser.  
Show the histogram. Circular histograms are displayed directly on the stereonet. Regular histograms 
open as new Petrel windows. 

 Show All 
This feature is only available when the selected object in the Data Browser has non-displayed children.  
Show all the children nodes of the selected node. 

 Hide All 
This feature is only available when the selected object in the Data Browser has displayed children.  
Hide all the children nodes of the selected node. 
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 Import Data         Ctrl+Shift+I 
Allow for data import from Petrel objects. 
(1): The Petrel Blue Arrow can be used for easy import. 
(2): Traditional combo-boxes can as well be used, at your convenience. 
(3): INT Stereonet 1.0 allows for data import from Surfaces, Reservoir Grids and Point Sets. 
(4): Several sampling algorithms allow for resampling data without altering its quality. 
 

By convention, dip values range from 0 to 180 and azimuth values range from 0 to 360. If import 
data does not fit this convention, calculations convert values to fit those ranges. 

INT Stereonet 1.0 allows for four types of sampling: 

• Fast: Resampling with equi-probability of selection through the source dataset.  
• Density-faithful: Sampled data set honors source dataset density. 
• Dip Angle Repartition: Sampled data set honors source dataset dip angle distribution. 
• Azimuth Repartition: Sampled data set honors source dataset azimuth distribution. 

INT Stereonet recognizes the following dip angle / azimuth convention: 
 - dip angle: the angle (in degrees) between the plane and the horizontal; 
 - azimuth: the North-referred direction (in degrees)  of the slope. 
 
 
 
 
 
 
 

  

Figure 2: The Import Data control allows for import and resample circular data from Petrel objects 

azimuth
 Dip angle 
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 View data         Ctrl+Shift+W 
This feature is not available if the selected object of the Data Browser is a directory.  
Allow for data visualization as numerical values. The table is automatically updated when a new object is 
selected in the Data Browser. Both point sets and histograms can be displayed. 

 

 Edit data         Ctrl+Shift+E 
This feature is only available if the selected object of the Data Browser is a data set.  
The Edit Data control allows for direct data edition: 

• Add new point: Add a point to the data set at a given dip and azimuth value. 
• Only keep in range: Remove all points which are not in the selected dip/azimuth range. 
• Remove in range: Remove all points in the selected dip/azimuth range.  

Figure 3 : Data Visualization for Point Sets (1) and Histograms (2). 

Figure 4: Data Edition using simple menus 

1 

2 
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 Preferences          
This feature is not available if the selected object of the Data Browser is a directory. 
Preferences allows for display customization. Depending on the selected object in the Data Browser, the 
control may have different aspect: 

 Sets of Points 
Series of points can easily be customized: 

• Name can be changed 
• 7 types of symbol are available 
• RGB color with transparency 
• Symbol size can be set 

The user can show or hide points directly with the Displayed checkbox. 

Areas on the right are dedicated to preview the new symbol customization compare to the current one, 
before applying all changes. 

 Circular histograms 
Circular histograms can also be customized. However, the user cannot change the name of the 
histogram unless it has been copied under another directory. The histogram can be displayed or not 
using the Displayed checkbox. 

If displaying several circular histograms on the chart, the bins size should be the same for all. To 
define the bin size of a circular histogram, please refer to Canvas Properties. 

Figure 5: Preferences edition for points 

Figure 6: Preferences edition for circular histograms 
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 Regular histograms 
Regular histograms can also be customized. The user cannot change the name of the histogram unless it 
has been copied under another directory. 

In 1.0, three scales can be used for visualization: 0-90 degrees, 90-180 degrees, and 0-180 degrees. 
The bins size is defined for each histogram. By default, the histogram is displayed with the most logical 
scale, calculated from the series of points. 

 Generate Statistics / Refresh Statistics    Ctrl+Shift+M 
This feature is only accessible if a set of points is selected in the Data Browser. 
Statistics generation produces a Statistics directory below the source object. Variance, Standard 
deviation, Minimum, Maximum, Median, Dips and Azimuths Distributions are computed, and stored 
under this directory. Generated statistics honors specificities of circular series1.  
 
Statistics can be affected by data edition. Then, available statistics can be refreshed at the user request 
using the Refresh Statistics feature. 

Refresh statistics does not recover deleted objects. To recover statistics, use Re-Generate 
Statistics. 

 

 Recover Statistics 
This feature is only accessible if a set of statistics is missing. 
Refresh Statistics with full data recovery. 

 

 

 

 

1 : J. Borradaile. Statistics of Earth Science Data : their distribution in space, time and orientation. Springer, 1st 
edition, 2003.  
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 Create a Family by Operations      Ctrl+Shift+F 
A new family of points can be generated using mathematical operations from existing data sets: 

•  Copy: create a new family which is the copy of the input family. Eventual children 
associated to the source data set are not copied. 

•   Copy (with Exclusion): copy a data set while removing all points belonging to 
another one. 

•  Intersection: create a new family using only points belonging to the selected 
datasets. 

•  Union: create a new family using all points belonging to at least one of the two 
selected datasets. Points belonging to the datasets intersection are only copied once.  

  

Figure 7: Family by Operation edition 
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Canvas Menu 
The Canvas menu allows for Canvas (graphic area) edition or customization. 

 Zoom in 
Increase the zoom of the chart. The center of the graphic will focus on the same point, before and after 
the zoom. 

 Zoom out 
This feature is only accessible if the zoom is higher than the default one. 
Decrease the zoom of the chart. The center of the graphic will focus on the same point, before and after 
the zoom. 

 Reset zoom 
This feature is only accessible if the zoom is higher than the default one. 
Reset the zoom of the chart to the default zoom (1:1). The center of the graphic is reset as well. 

 Preferences         Ctrl+Shift+G 
This feature is also accessible from right-clicking on the canvas. 
This control allows changing: 

• Azimuth Increment: Spacing (in degrees) between two azimuth radiuses, starting from 0. 
• Dip Increment: Spacing (in degrees) between two dip circles, starting from 0. 
• Global Rotation: Rotation of the North (0-value), using direct convention. 
• Petal Bins Size: Width (in degrees) of circular histogram bins. 

 The maximum Petal Bins Size allowed is 360 degrees (only 1 bin displayed on the chart). 
 The minimum Petal Bins Size minimum is 0.001 degree. 

 

 

Figure 8: Diagram Preferences control 
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 Export Chart as an Image 
This feature is also accessible by right-clicking the canvas. 
Export the chart as an image. The picture can be saved in several common formats. The picture size is 
485*485 pixels.  

 The chart will be exported with the default zoom, even if the chart has been zoomed in. 

 Copy Chart to Clipboard 
This feature is also accessible by right-clicking the canvas. 
Copy the chart to the clipboard, so it can be pasted into another application.  

 The chart will be copied with the default zoom, even if the chart has been zoomed in. 
 

 Copy Legend to Clipboard 

This feature is also accessible by right-clicking the object tree. 
Copy the object tree to the clipboard, so it can be pasted into another application. 

 

Help Menu 
The Help menu allows for recovering information and support. 

 Help    `      Shift+F1  
Open the Help Box with INT contacts for support. 

 About         Shift+F2 
Open the About Box with details about the plug-in version. 

Figure 9: Diagram Preferences control 
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